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1 General information

This bus controller makes it possible to connect X2X Link I/O nodes to PROFINET. PROFINET uses TCP/IP and is
capable of using Ethernet in real time. PROFINET IO was developed for real-time (RT) and isochronous real-time
(IRT) communication with the decentralized periphery. The designations RT and IRT merely describe the real-time
properties for communication taking place within PROFINET IO.

1.1 Brief overview of properties

The following list includes some of the main properties of B&R PROFINET bus controllers.

• PROFINET RT - Conformance Class B
• Possible to fully configure X2X I/O modules via the fieldbus
• Firmware updates via integrated website
• Integrated switch for wiring multiple slaves
• Up to 1440 bytes of I/O data possible
• 100 Mbit/s full-duplex mode
• Bus controller and I/O module diagnostics at runtime via master environment or website
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2 X20 technical description

2.1 Order data
Model number Short description Figure

Bus controllers
X20BC00E3 X20 bus controller, 1 PROFINET IO interface, integrated 2-port

switch, 2x RJ45, order bus base, power supply module and ter-
minal block separately!

X20cBC00E3 X20 bus controller, coated, 1 PROFINET IO interface, integrated
2-port switch, 2x RJ45, order bus base, power supply module
and terminal block separately!
Required accessories
System modules for bus controllers

X20BB80 X20 bus base, for X20 base module (BC, HB, etc.) and X20 pow-
er supply module, X20 end plates (left and right) X20AC0SL1/
X20AC0SR1 included

X20PS9400 X20 power supply module, for bus controller and internal I/O
power supply, X2X Link power supply

X20PS9402 X20 power supply module, for bus controller and internal I/O
power supply, X2X Link power supply, supply not electrically iso-
lated

X20cBB80 X20 bus base, coated, for X20 base module (BC, HB, etc.)
and X20 power supply module, X20 end plates (left and right)
X20AC0SL1/X20AC0SR1 included

X20cPS9400 X20 power supply module, coated, for bus controller and internal
I/O power supply, X2X Link power supply
Terminal blocks

X20TB12 X20 terminal block, 12-pin, 24 VDC keyed

Table 1: X20BC00E3, X20cBC00E3 - Order data
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2.2 Technical data
Model number X20BC00E3 X20cBC00E3
Short description
Bus controller PROFINET IO slave
General information
B&R ID code 0xBB7D 0xE4E0
Status indicators Module status, bus function
Diagnostics

Module status Yes, using status LED and software
Bus function Yes, using status LED and software

Power consumption
Bus 2.5 W

Additional power dissipation caused by actuators
(resistive) [W]

-

Certifications
CE Yes
EAC Yes
UL cULus E115267

Industrial control equipment
HazLoc cCSAus 244665

Process control equipment
for hazardous locations

Class I, Division 2, Groups ABCD, T5
ATEX Zone 2, II 3G Ex nA nC IIA T5 Gc

IP20, Ta (see X20 user's manual)
FTZÚ 09 ATEX 0083X

Interfaces
Fieldbus PROFINET IO slave
Variant 2x shielded RJ45 (switch)
Line length Max. 100 m between 2 stations (segment length)
Transfer rate 100 Mbit/s
Transfer

Physical layer 100BASE-TX
Half-duplex Yes
Full-duplex Yes
Autonegotiation Yes
Auto-MDI / MDIX Yes

Min. cycle time 1)

Fieldbus 1 ms
X2X Link 250 μs

Synchronization between bus systems possible Yes
Electrical properties
Electrical isolation PROFINET isolated from bus and I/O
Operating conditions
Mounting orientation

Horizontal Yes
Vertical Yes

Installation elevation above sea level
0 to 2000 m No limitations
>2000 m Reduction of ambient temperature by 0.5°C per 100 m

Degree of protection per EN 60529 IP20
Ambient conditions
Temperature

Operation
Horizontal mounting orientation -25 to 60°C
Vertical mounting orientation -25 to 50°C

Derating -
Storage -40 to 85°C
Transport -40 to 85°C

Relative humidity
Operation 5 to 95%, non-condensing Up to 100%, condensing
Storage 5 to 95%, non-condensing
Transport 5 to 95%, non-condensing

Mechanical properties
Note Order 1x X20TB12 terminal block separately

Order 1x X20PS9400 or X20PS9402
power supply module separately

Order 1x X20BB80 bus base separately

Order 1x X20TB12 terminal block separately
Order 1x X20cPS9400 pow-
er supply module separately

Order 1x X20cBB80 bus base separately
Spacing 2) 37.5 +0.2 mm

Table 2: X20BC00E3, X20cBC00E3 - Technical data

1) The minimum cycle time defines how far the bus cycle can be reduced without communication errors occurring.
2) Spacing is based on the width of the X20BB80 bus base. In addition, an X20PS9400 or X20PS9402 supply module is always required for the bus controller.
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2.3 LED status indicators

The following table lists the LED status indicators available on the bus controller. Exact blink times are specified
in the timing diagram in the next section.

Figure LED Color Status Description
Off The PROFINET master is in "Stop" mode.
Quad flash The bus controller does not have a valid IP address (0.0.0.0). It will wait in this

state until it is assigned an IP address from the PROFINET master or from an
external source. This state can also occur if the bus controller is being operated
in DHCP mode.

Double flash An unacknowledged alarm is pending on the bus controller.
Blinking 1 The bus controller is in the initialization phase. This boot phase is where all con-

nected I/O modules are initialized.
Blinking 3 The bus controller is configuring the connected I/O modules. The configuration

is transferred to the bus controller via the PROFINET master.

Green

On A connection to a PROFINET master has been established. The master and
slave are both in OPERATIONAL mode and data is being exchanged between
them.
This mode also indicates that the master itself is in RUN mode.

Blinking 4 The bus controller has detected an error. However, it can still be corrected in the
master environment during runtime.

MS1)

Red

Blinking 1 The bus controller has detected an error. This error cannot be corrected during
runtime; a restart is required.

Blinking 2 Device identification ("blink" function in step 7 when searching for existing Eth-
ernet stations).

Green

On A connection to a PROFINET master has been established.

BF1)

Red On Not connected to a PROFINET Master
Off Indicates that no physical Ethernet connection exists
Blinking Ethernet activity taking place on the RJ45 interface (IF1, IF2) indicated by the

respective LED

L/A IFx Green

On Indicates an established connection (link), but no communication is taking place

1) The "MS" and "BF" LEDs are green/red dual LEDs.

LED status indicators - Blinking patterns

150

250

300

300

300

300

300

300

300 300 300 300 1500

1500

500

1000

Quad flash

Double flash

Blinking 1

Blinking 2

Blinking 3

Blinking 4

All times in ms

2.3.1 Error display

When the bus controller determines that a configured I/O module is not physically connected, or that an incorrect
module is connected, this error is indicated via the MS LED. If the bus controller is set to "Warning", then it blinks
green; otherwise, it blinks red once per second (Blinking 4).
Information regarding the status of the bus controller can be read directly in the master environment. For a list
of corresponding alarm codes with textual descriptions, see section "Diagnostics system and alarm status codes"
on page 27.



 X20 technical description

PROFINET IO user's manual Bus controller 1.45 9

2.4 Operating and connection elements

LED status indicators

PROFINIET RT connection with
2x RJ45 for simple wiring

Node number switches

Terminal block for bus controller
and I/O supply

2.5 Ethernet interface

For information about wiring X20 modules with an Ethernet interface, see section "Mechanical and electrical con-
figuration - Wiring guidelines for X20 modules with Ethernet cables" of the X20 user's manual.

IF1

IF2

PinoutInterface
Pin Ethernet
1 RXD Receive data
2 RXD\ Receive data\
3 TXD Transmit data
4 Termination
5 Termination
6 TXD\ Transmit data\
7 Termination

1

RJ45 shielded
8 Termination
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2.6 Node number switches

The bus controller has 2 node number switches. The bus controller can be set to different operating modes using
certain, pre-defined switch positions. They can also be used to configure various additional parameters (PROFINET
device name, DHCP mode, etc.).

Switch position Description
0x00 All parameters are loaded from flash memory: Default PROFINET initialization via the DCP protocol (factory state)

0x01 - 0xEF These switch positions generate a valid PROFINET device name. This name is composed as follows: "brpnXXX".
XXX refers to the decimal value of the node number switch position. The system automatically adds any necessary
leading 0s.
Example
The node number switch must be set to 12. The name must consist of "brpn + node number" (three-digit node
number). The resulting name is "brpn012".

0xF0 Clears flash (see "Erasing flash memory" on page 19)
0xF1 - 0xFD Reserved, switch position not permitted

0xFE IP address via DHCP server
0xFF All parameters set to default: PME mode

Parameters Value
IP address 0.0.0.0
Subnet mask 0.0.0.0
Gateway 0.0.0.0
PROFINET device name "" → no factory default name

Parameters cannot be changed by the master in node switch position 0xFF.
Parameters Value
IP address 192.168.100.1
Subnet mask 255.255.255.0
Gateway 192168100254
PROFINET device name x20bc00e3
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3 X67 technical description

3.1 Order data
Model number Short description Figure

Bus controller modules
X67BCE321.L12 X67 bus controller, 1 PROFINET interface, X2X Link power sup-

ply 15 W, 16 digital channels configurable as inputs or outputs,
24 VDC, 0.5 A, configurable input filter, 2 event counters 50 kHz,
M12 connectors, high-density module

Table 3: X67BCE321.L12 - Order data

Required accessories
See "Required cables and connectors" on page 16.
For a general overview, see section "Accessories - General overview" of the X67 system user's manual.
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3.2 Technical data
Model number X67BCE321.L12
Short description
Bus controller PROFINET IO slave
General information
Inputs/Outputs 16 digital channels, configurable as inputs or outputs using software, inputs with additional functions
Isolation voltage between channel and bus 500 Veff

Nominal voltage 24 VDC
B&R ID code

Bus controller 0xC5E8
Internal I/O module 0xD9CB

Sensor/Actuator power supply 0.5 A summation current
Status indicators I/O function per channel, supply voltage, bus function
Diagnostics

Outputs Yes, using LED status indicator and software
I/O power supply Yes, using LED status indicator and software

Connection type
Fieldbus M12, D-coded
X2X Link M12, B-coded
Inputs/Outputs 8x M12, A-coded
I/O power supply M8, 4-pin

Power output 15 W X2X Link power supply for I/O modules
Power consumption

Fieldbus 4.2 W
Internal I/O 2.5 W
X2X Link power supply 24.3 W at maximum power output for connected I/O modules

Certifications
CE Yes
EAC Yes
UL cULus E115267

Industrial control equipment
HazLoc cCSAus 244665

Process control equipment
for hazardous locations

Class I, Division 2, Groups ABCD, T5
ATEX Zone 2, II 3G Ex nA IIA T5 Gc

IP67, Ta = 0 - Max. 60°C
TÜV 05 ATEX 7201X

Interfaces
Fieldbus PROFINET IO slave
Variant 2x M12 interface (switch), 2x female connector on the module
Line length Max. 100 m between 2 stations (segment length)
Transfer rate 100 Mbit/s
Transfer

Physical layer 100BASE-TX
Half-duplex Yes
Full-duplex Yes
Autonegotiation Yes
Auto-MDI / MDIX Yes

Min. cycle time 1)

Fieldbus 1 ms
X2X Link 250 μs

Synchronization between bus systems possible Yes
I/O power supply
Nominal voltage 24 VDC
Voltage range 18 to 30 VDC
Integrated protection Reverse polarity protection
Power consumption

Sensor/Actuator power supply Max. 12 W 2)

Sensor/Actuator power supply
Voltage I/O power supply minus voltage drop for short-circuit protection
Voltage drop for short-circuit protection at 0.5 A Max. 2 VDC
Summation current Max. 0.5 A
Short-circuit proof Yes
Digital inputs
Input voltage 18 to 30 VDC
Input current at 24 VDC Typ. 4 mA
Input characteristics per EN 61131-2 Type 1
Input filter

Hardware ≤10 μs (channels 1 to 4) / ≤70 µs (channels 5 to 16)
Software Default 0 ms, configurable between 0 and 25 ms in 0.2 ms intervals

Input circuit Sink
Additional functions 50 kHz event counting, gate measurement

Table 4: X67BCE321.L12 - Technical data
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Model number X67BCE321.L12
Input resistance Typ. 6 kΩ
Switching threshold

Low <5 VDC
High >15 VDC

Event counter
Quantity 2
Signal form Square wave pulse
Evaluation Each negative edge, cyclic counter
Input frequency Max. 50 kHz
Counter 1 Input 1
Counter 2 Input 3
Counter frequency Max. 50 kHz
Counter size 16-bit
Gate measurement
Quantity 1
Signal form Square wave pulse
Evaluation Positive edge - Negative edge
Counter frequency

Internal 48 MHz, 3 MHz, 187.5 kHz
Counter size 16-bit
Length of pause between pulses ≥100 µs
Pulse length ≥20 µs
Supported inputs Input 2
Digital outputs
Variant FET positive switching
Switching voltage I/O power supply minus residual voltage
Nominal output current 0.5 A
Total nominal current 8 A
Output circuit Source
Output protection Thermal shutdown in the event of overcurrent or short circuit, integrated protection

for switching inductive loads, reverse polarity protection of the output power supply
Diagnostic status Output monitoring with 10 ms delay
Leakage current when switched off 5 µA
Switching on after overload shutdown Approx. 10 ms (depends on the module temperature)
Residual voltage <0.3 V at 0.5 A nominal current
Peak short-circuit current <12 A
Switching delay

0 → 1 <400 µs
1 → 0 <400 µs

Switching frequency
Resistive load Max. 100 Hz
Inductive load See section "Switching inductive loads".

Braking voltage when switching off inductive loads 50 VDC
Electrical properties
Electrical isolation Bus isolated from PROFINET and channel

Channel not isolated from channel
Operating conditions
Mounting orientation

Any Yes
Installation elevation above sea level

0 to 2000 m No limitation
>2000 m Reduction of ambient temperature by 0.5°C per 100 m

Degree of protection per EN 60529 IP67
Ambient conditions
Temperature

Operation -25 to 60°C
Derating -
Storage -40 to 85°C
Transport -40 to 85°C

Mechanical properties
Dimensions

Width 53 mm
Height 155 mm
Depth 42 mm

Weight 350 g
Torque for connections

M8 Max. 0.4 Nm
M12 Max. 0.6 Nm

Table 4: X67BCE321.L12 - Technical data

1) The minimum cycle time specifies the time up to which the bus cycle can be reduced without communication errors occurring.
2) The power consumption of the sensors and actuators connected to the module is not permitted to exceed 12 W.
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3.3 LED status indicators
Figure LED Color Status Description

Status indicator 1
On Connection has been established to a PROFINET master. The master

and slave are both operational and data is being exchanged between
them. This state also indicates that the master itself is in the RUN state.

Blinking 1 The bus controller is in the initialization phase. This boot phase is where
all connected I/O modules are initialized.

Blinking 3 The bus controller is configuring the connected I/O modules. The con-
figuration is transferred to the bus controller via the PROFINET master.

Green

Double flash An unacknowledged alarm is pending on the bus controller.
On Not connected to a PROFINET master
Quad flash The bus controller does not have a valid IP address (0.0.0.0). It will wait

in this state until it is assigned an IP address from the PROFINET master
or from an external source. This state can also occur if the bus controller
is being operated in DHCP mode.

Blinking 4 The bus controller has detected an error. However, it can still be correct-
ed in the master environment during runtime.

Red

Blinking 1 The bus controller has detected an error. This error cannot be corrected
during runtime; a restart is required.

MS and BF (combined)

Off The PROFINET master is in state "Stop" or the BC is not running (power
supply, etc.)

On Indicates an established connection (link), but no communication is tak-
ing place

Green

Blinking Ethernet activity taking place on the interface (IF1, IF2) indicated by the
LED

Blinking 2 Device identification ("blink" function in step 7 when searching for exist-
ing Ethernet stations)

L/A IF1 & IF2 (com-
bined)

Red

Off An active connection or link does not exist. No other device (PC,
PROFINET master / slave) connected to any interface (IF1, IF2).

I/O LEDs
1-1/2 to 8-1/2 Orange - Input/Output status of the corresponding channel
Status indicator 2

Off No power to module
Single flash No power to module
Blinking PREOPERATIONAL mode

Left Green

On RUN mode
Off No power to module or everything OK
On Error or reset status
Single flash Warning or error on an I/O channel. Level monitoring for digital outputs

has been triggered.

 
 

Status indicator 1:
Left: L/A IF; right: MS & BF

Status indicator 2:
Left: green, Right: red

1-1 5-1

1-2
2-1

5-2

2-2
3-1

3-2
4-1 8-1

4-2 8-2

6-1

6-2
7-1

7-2

Right Red

Double flash Supply voltage not in the valid range

Status indicator 1 LED - Blink times

150

250

300

300

300

300

300

300

300 300 300 300 1500

1500

500

1000

Quad flash

Double flash

Blinking 1

Blinking 2

Blinking 3

Blinking 4

All times in ms

3.3.1 Error display

When the bus controller determines that a configured I/O module is not physically connected, or that an incorrect
module is connected, this error is indicated via the MS LED. If the bus controller is set to "Warning", then it blinks
green; otherwise, it blinks red once per second (Blinking 4).
Information regarding the status of the bus controller can be read directly in the master environment. For a list
of corresponding alarm codes with textual descriptions, see section "Diagnostics system and alarm status codes"
on page 27.
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3.4 Operating and connection elements

Digital inputs/outputs 1 to 16

24 VDC I/O power supply
Connector C: Supply
Connector D: Routing

Fieldbus interface
Connector A: Input
Connector B1: Output

X2X Link
Connector B2: Output

3.5 PROFINET interfaces

The module is connected to a PROFINET network using pre-assembled cables. The connection is made using a
circular connector (M12, 4-pin).

Connection Pinout
Pin PROFINET
1 TXD Transmit data
2 RXD Receive data
3 TXD\ Transmit data\
4 RXD\ Receive data\

1

4

2

3

A

1
4

2

3

B1

A ... D-keyed female connector in module, PROFINET IN
B1 ... D-keyed female connector in module, PROFINET OUT
SHLD ... Shielding provided by threaded insert in the module

Information:
The color of the wires used in field-assembled cables for connecting to the PROFINET interfaces may
deviate from the standard.
Make sure to check proper pinout (see X67 system user's manual).
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3.5.1 Required cables and connectors

POWERLINK
Attachment cable or
X67CA0E41.xxxx

I/O power supply
Attachment cables
X67CA0P20.xxxx
X67CA0P30.xxxx

POWERLINK
Connection cables
X67CA0E61.xxxx

X2X Link
Connection cables
X67CA0X01.xxxx
X67CA0X11.xxxx

I/O power supply
Connection cables
X67CA0P00.xxxx
X67CA0P10.xxxx

X2X Link
Open-ended cables
X67CA0X41.xxxx
X67CA0X51.xxxx

X67BC

I/O

X67BC

I/O

X67BC

I/O

I/O power supply
Open-ended cables
X67CA0P40.xxxx
X67CA0P50.xxxx

POWERLINK
Attachment cables
X67CA0E41.xxxx

POWERLINK
Field-assembled connector
X67AC2E01

3.6 Node number switches

The bus controller has 2 node number switches. The bus controller can be set to different operating modes using
certain, pre-defined switch positions. They can also be used to configure various additional parameters (PROFINET
device name, DHCP mode, etc.).

Switch position Description
0x00 All parameters are loaded from flash memory: Default PROFINET initialization via the DCP protocol (factory state)

0x01 - 0xEF These switch positions generate a valid PROFINET device name. This name is composed as follows: "brpnXXX".
XXX refers to the decimal value of the node number switch position. The system automatically adds any necessary
leading 0s.
Example
The node number switch must be set to 12. The name must consist of "brpn + node number" (three-digit node
number). The resulting name is "brpn012".

0xF0 Clears flash (see "Erasing flash memory" on page 19)
0xF1 - 0xFD Reserved, switch position not permitted

0xFE IP address via DHCP server
0xFF All parameters set to default: PME mode

Parameters Value
IP address 0.0.0.0
Subnet mask 0.0.0.0
Gateway 0.0.0.0
PROFINET device name "" → no factory default name

Parameters cannot be changed by the master in node switch position 0xFF.
Parameters Value
IP address 192.168.100.1
Subnet mask 255.255.255.0
Gateway 192168100254
PROFINET device name x67bce321.l12
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3.7 Integrated mixed module

The full functionality of the X67DM1321.L12 mixed module is integrated in the X67BCE321.L12 bus controller
module by default.
The following is a list of features provided by the mixed module.

■ 16 digital mixed channels, can be configured as input or output
■ Replacement of passive distributors
■ Configurable digital input filters
■ 2 additional channels with counter functions
■ All outputs with single-channel diagnostics
■ Extensive additional status information

Further information regarding configuration and technical data can be found in the X67DM1321.L12 module data
sheet, available from the B&R website www.br-automation.com.

http://www.br-automation.com
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4 Basic information

4.1 General information

The B&R PROFINET bus controller enables the modular B&R I/O systems X20, X67 and XV to be integrated in
PROFINET. Up to 253 I/O modules can be connected to a bus controller using the X2X system bus from B&R. This
system bus is synchronized with the PROFINET fieldbus in order to achieve optimum performance.
Information regarding the configuration of B&R PROFINET bus controllers is provided to the master using GSDML
files. These XML files contain all of the slave and master parameters needed to integrate them into a PROFINET
master environment. These GSDML files can be downloaded from the B&R website www.br-automation.com in
the respective bus controller's download section; they must then usually be imported into the applicable master
environment.
When the bus controller is started, the I/O modules configured in the master environment are detected and their
I/O data points are assigned.

4.2 Blink codes during startup

The boot loader indicates the following states on the "MS" module status LED:

Boot from 0

Boot from upgrade

Header not found

Header checksum error

Firmware checksum error

500 ms

50 ms

50 ms

50 ms

50 ms

>200 ms

300 ms

300 ms

200 ms

>1 s

500 ms >200 ms

50 ms

50 ms 50 ms

>1 s

300 ms >1 s ... Restart

... Restart

... Restart

... LED controlled by firmware 

... LED controlled by firmware 

Figure 1: Blink codes during startup

If faulty firmware in the flash memory causes an error during booting, then the system will attempt to reboot using
the factory default boot block.
In other words, if an error occurs in the firmware upgrade sector, then the module will automatically revert to the
factory default sector (boot from 0).

4.3 Forcing a boot from the factory default sector

This is necessary if firmware has been stored in the upgrade sector, operates the watchdog correctly but doesn't
allow the booting process to occur without errors. The boot loader simply starts the defective firmware and doesn't
provide a way to carry out a subsequent update.
To force a boot from the factory default sector, one of the network address switches must be moved continuously
during booting. This is detected by the boot loader, which causes the "MS" module status LED to begin flashing
red quite very rapidly. After 1 second passes where the network address switch is no longer changed, the bus
controller restarts using the factory default boot sector and the current network address switch.

4.4 Boot procedure

Switching on the power triggers the initialization phase. When the connection to the master is established, the bus
controller receives information about the I/O module configuration and registers the modules configured on the
X2X link. A mapping of the I/O data is also generated. If there is a problem during booting (e.g. module not inserted
or wrong module inserted), then the bus controller will indicate the situation via the status LED's blink code (see
"LED status indicators" on page 8).
A previously used configuration is stored in flash memory, but it is overwritten when the connection is established
between the master and the slave. It is also possible for the user to delete the configuration stored in flash memory
by setting the node number switches accordingly.

http://www.br-automation.com
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4.5 I/O configuration

With PROFINET bus controllers, each I/O module is uniformly configured by the master environment and its sup-
plied GSDML file. Once the GSDML file has been imported into the master environment, it is possible to configure
the module as needed. In addition, extra module-specific parameters are created for each module. The created
configuration is transferred to the bus controller when it is loaded or when the connection is established between
the PROFINET master and the slave.

4.6 XML description file

The supplied XML description file (GSDML file) contains all information about how the process data (I/O data) is
structured as well as the configuration data for the bus controller and the I/O modules.
Most master environments, e.g. SIMATIC Step 7, allow this description file to be imported. The advantage of this
method is that all I/O data points are already known (name, type) in the development environment without actually
having to have a physical device present. In addition, the XML description file also specifies that configuration
data should be sent to the bus controller during booting. In other words, the master always has access to the
configuration automatically. Master systems configured in this way thus do not require a service technician to
manually load the configuration to the bus controller during commissioning or when existing bus controllers are
being replaced.

4.7 Erasing flash memory

Erasing flash memory using switch position 0xF0 returns the bus controller to its factory state.
Steps to be performed

1. Turn off the power supply to the bus controller.
2. Set the node number to 0xF0.
3. Turn on the power supply to the bus controller.
4. Wait until the "MS" LED flashes green for 5 s. The node number switch must be set to 0x00 and then back

to 0xF0 within this time window of 5 seconds (rotate the top or left switch respectively).
5. Wait until the "MS" LED blinks with a red double-flash (flash has been cleared).
6. Turn off the power supply to the bus controller.
7. Set the desired node number (0x00 - 0xEF)
8. Turn on the power supply to the bus controller.
9. The bus controller boots with the configured node number.
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5 Bus controller preconfiguration

5.1 Changing PROFINET device names with Automation Studio

There are several ways of changing the name of a PROFINET device:

• Modifying with the node number switch
In this case, the name of the device is automatically generated. (see section "X20 node number switches"
on page 10 or "X67 node number switches" on page 16)

• Modifying with an external tool (e.g. Automation Studio)
In this case, the PROFINET device can be assigned any name.

Assigning a PROFINET name using Automation Studio
● To change the name of the PROFINET device, the Device Configuration item is selected in Automation Studio
in the shortcut menu on the PROFINET (DTM) interface of the respective device.
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● All devices connected to this interface can be searched for in the configuration dialog box via Settings → Ethernet
Devices using Search Devices.

● After selecting the desired PROFINET device from the list, a random name can be entered in the Set Name tab.
The new name is applied with the Set Name interface and the change is confirmed by clicking OK.
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5.2 Configuration using Step 7 configuration tool

A successful PROFINET connection between a master and a slave can only be established if the bus controller has
the same device name that is specified in the hardware configuration. If these device names do not match, valid
PROFINET communication will never take place. With their Step 7 development environment, Siemens provides
a tool to pre-configure PROFINET devices. It uses their unique MAC address to identify PROFINET devices. It
is then possible to configure additional parameters such as the IP address or the PROFINET device name. In
addition, this tool can be used to reset PROFINET devices to their factory state. Configured parameters are saved
permanently to the device. B&R PROFINET bus controllers are delivered with the following settings.
The Step 7 configuration tool ignores capital letters when assigning device names. For example, if the
name "X67BCE321.L12" is assigned, the bus controller is actually referred to as "x67bce321.l12" after
configuration.

Bus controller factory settings:

PROFINET device name = ""
IP address = 0.0.0.0
Subnet mask = 0.0.0.0
Default gateway = 0.0.0.0

Example

Configuring the X67BCE321.L12 bus controller.

● In the SIMATIC Manager, select PLC → Edit Ethernet Node to open the configuration dialog box.

● In the Edit Ethernet Node dialog box, all PROFINET devices in the network are shown by clicking Browse .
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● In the Browse Network dialog box, select the desired PROFINET device and confirm by clicking OK.
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● The IP address and device name can now by entered in the Edit Ethernet Node dialog box.
The IP address and subnet mask can be manually entered in the Use IP parameters section and specified using
Assign IP Configuration. This IP address is used for things such as calling up the device's web server.
The desired device name can be entered in the Device name edit field. This name is used to address the device
in PROFINET. Click on Assign Name to set the name.
Reset resets all settings to the factory defaults.
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6 GSDML description

6.1 The GSDML description file

The GSDML description file, available for download from the B&R website, is used to configure the bus controller
and supported I/O modules. GSDML files are based on XML as well as a standard developed by the PNO user
organization. Using this file, the bus controller is defined as an interface and can thus be configured in a master
environment as a PROFINET device. The data points to be registered as well as the configuration registers are
noted by the defined I/O modules. When a configuration is created and downloaded, the master is able to identify
and register the bus controller. In addition, the bus controller uses the data present in the GSDML file to identify
the configured I/O modules and register them on the X2X Link. If needed, each module can then be configured
separately (and differently) in the master environment. When the configuration data is modified, the new configu-
ration is downloaded again and transferred to the bus controller and then on to the respective I/O module.

6.2 Bus controller configuration

When configuring B&R PROFINET bus controllers, it is possible to set certain parameters such as the X2X cycle
time. These parameters are then applied when the configuration is downloaded. Configurable parameters are
noted in the GSDML file and interpreted accordingly by the bus controller.

6.2.1 Configuring the X2X cycle time

X2X cycle time is the result of 2 decisive factors. First, the PROFINET cycle time is taken into account when
calculating the X2X cycle time. Second, the user can use an X2X reduction factor to further configure the desired
X2X cycle time. The basic rule of thumb is that the X2X cycle time can never exceed the PROFINET cycle time.
The following table provides an overview of possible configurations.

X2X reduction factorPROFINET cycle time [ms]
1 2 4 8 16 32 64 128

1 1000 500 250 250 250 250 250 250
2 2000 1000 500 250 250 250 250 250
4 4000 2000 1000 500 250 250 250 250
8 4000 4000 2000 1000 500 250 250 250

16 4000 4000 4000 2000 1000 500 250 250
32 4000 4000 4000 4000 2000 1000 500 250
64 4000 4000 4000 4000 4000 2000 1000 500

128 4000 4000 4000 4000 4000 4000 2000 1000
256 4000 4000 4000 4000 4000 4000 4000 2000
512 4000 4000 4000 4000 4000 4000 4000 4000

6.2.2 X2X module initialization delay

This parameter allows the user to tell the bus controller how long the boot phase should last if a module is missing.
If the bus controller determines that a configured module is not physically present during booting, it will wait this
predefined time before ultimately switching to the RUN state and returning the corresponding error message. If all
configured modules are physically present and correctly inserted during booting, the bus controller will still switch
to the "operational" state immediately without waiting for the initialization delay to elapse. This parameter can be
set to between 3 to 60 seconds and can be configured by the user in milliseconds. This parameter is configured
in the master environment.
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6.2.3 I/O Endian format

In certain circumstances, different PROFINET master systems also operate with a different I/O Endian format.
Therefore the bus controller contains a configuration parameter for changing between Big and Little Endian format.
This ensures that the stored I/O data will be displayed properly regardless of the master environment.

6.2.4 Event IOM_MISSING

An alarm is triggered by default when the event IOM_MISSING occurs (at startup, the bus controller detects that
a configured I/O module is missing). However, this alarm can also be suppressed for application scenarios where
it is not desired. The user can set whether this I/O module event should be interpreted as an alarm or just as a
warning. The basic difference is that a warning only emits a green warning code instead of a red blink code.

6.2.5 Event IOM_FAILED

An alarm is triggered by default when the event IOM_FAILED occurs (during operation, the bus controller detects
that a module which was present during startup is no longer providing a valid status). A red alarm blink code is
used to notify the user. This alarm may not be desired in all situations. Therefore, the user can configure whether
the IOM_FAILED event should be interpreted as an error or just as a warning. The basic difference is that an error
triggers a red blink code. If the event is interpreted as a just warning, then only a green warning code is output.

6.3 Special module entries

6.3.1 ModuleOK

The ModuleOK data point specifies the status of the X2X module.
The return value 0xF5 indicates that there is no error and is composed as follows:

Bit Description
0 I/O bus supply, 1 = OK
1 Reserved
2 I/O bus, 1 = OK
3 DataValid, 0 = OK, 1 = Old data

4 - 7 Always 1

This results in the following values:
Description Value

(decimal)
Value
(hex)

X2X Link station inactive (e.g. no X2X Link power supply) 0 0x00
Everything OK (I/O data valid) 245 0xF5
No communication with the electronics module (bits 7 to 3 invalid) 249 0xF9
I/O data invalid, communication between X2X ASIC and electronics module OK (ASIC carried out a valid "Sync
in" transfer with the electronics module in the previous X2X Link cycle)

253 0xFD

Information:
Any value unequal to 245 (0xF5) means that the I/O data of the corresponding module is invalid. This
circumstance is usually taken into account or processed accordingly in the application.

6.3.2 "Special modules" module group

These modules had the status bytes removed in the GSDML (e.g. output status and ModuleOK). This is why only
output and input data is used. The master receives the module status of these modules via Channel Diagnosis.
(See "Structure of the diagnostics system" on page 27.)

Information:
This module group is only available in the GSDML description file starting in version 1.19.
These modules can only be used starting in firmware version 1.10.

A firmware update can be requested from International Support.
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7 Diagnostics system and alarm status codes

A PROFINET network is diagnosed using a detailed alarm system. Predefined alarms are generated in the slave
and transmitted to the master via the real-time channel. At runtime, these alarm texts are evaluated in the master
development environment and handled accordingly. A textual description of each alarm number is also included
in the GSDML description file. Since the GSDML file is integrated in the master environment, each defined alarm
number can be assigned a defined textual description using the GSDML file. Alarms are basically divided into 3
categories:

• Bus controller-specific alarms. These only affect the bus controller itself.
• I/O module alarms that are triggered, for example, by a missing I/O module
• Channel Diagnosis alarms for the individual I/O modules, in which the status registers of the individual X2X

modules are evaluated

In addition to the PROFINET alarms that are issued, the bus controller also indicates an error with corresponding
LED states.

7.1 Structure of the diagnostics system

Diagnostic information can be easily displayed by network analysis programs such as Wireshark. When using a
B&R PROFINET controller, the diagnostic information can be displayed in the Automation Studio Watch window
using library "AsNxPnM".
Example of a display

Display in Wireshark Display in Automation Studio

All diagnostic information and alarms are transmitted as 4 word or 8 USINT values. The values are defined as
follows:

Identification number Channel number Channel properties Error type

Word 1 Word 2 Word 3 Word 4Wireshark
Automation Studio USINT 1 USINT 2 USINT 3 USINT 4 USINT 5 USINT 6 USINT 7 USINT 8

Identification number (UserStructureIdentifier)

Always 0x8000: Only UserStructureIdentifier 0x8000 (Channel Diagnosis) is implemented in the B&R bus con-
troller.

Channel number (ChannelNumber)

The channel number indicates whether the error is an error at the channel level, i.e. a physically existing channel
of module 0x0000 to 0x7x7FFF, or at a higher level (submodule, module 0x8000).

Value Explanation
0x0000 - 0x7FFF Manufacturer-specific

0x8000 Submodules; Only one encoding for channel properties.
0x8001 - 0xFFFF Reserved
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Channel properties (ChannelProperties)

Channel properties contain detailed information about the channel(s) affected by the alarm or error message.

Specifier
Maintenance
Accumulative
Type

Bit

Direction

0123456789101112131415

Bit Value Text Explanation
ChannelProperties.Type

0x00 - Other data format or channel number is 0x8000
0x01 1-bit 1-bit data length of the channel
0x02 2-bit 2-bit data length of the channel
0x03 4-bit 4-bit data length of the channel
0x04 8-bit 8-bit data length of the channel
0x05 16-bit 16-bit data length of the channel
0x06 32-bit 32-bit data length of the channel
0x07 64-bit 64-bit data length of the channel

0 to 7

0x08 to 0xFF - Reserved
ChannelProperties.Accumulative

0x00 Single Diagnostics for displayed channel only8
0x01 Accumulative Diagnostics for multiple channels

ChannelProperties.Maintenance
0x00 Fault
0x01 Maintenance required
0x02 Maintenance absolutely necessary

9 to 10

0x03 For detailed information, see field "QualifiedChannelQualifier".
ChannelProperties.Specifier

0x00 All subsequent disappears No more alarm events for the channel
0x01 Appears Alarm event for channel occurred
0x02 Disappears Alarm event for channel disappeared

11 to 12

0x03 Disappears but others remain Alarm event for channel disappeared, but additional events for channel are avail-
able

ChannelProperties.Direction
0x00 Manufacturer-specific Manufacturer-specific
0x01 Input Input channel
0x02 Output Output channel
0x03 Input/Output Input/Output channel

13 to 15

0x04 to 0xFF Reserved

Error value (ChannelErrorType)

The error type contains the actual alarm or error message. Depending on the error number, they can be divided
into different categories:

● 0x0000 to 0x001F: See table "General alarms" on page 29.
● 0x0020 to 0x00FF: See table "Safety-related alarms" on page 30.
● 0x0200 to 0x041F: See tables "Manufacturer-defined alarms" on page 30.
● 0x8000 to 0xFFFF: See table "Network-related alarms" on page 32.
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7.1.1 Disabling/Enabling Channel Diagnosis

Channel Diagnosis is disabled on the bus controller by default. It can be enabled by setting parameter "IOM Channel
Diagnosis" to "Enable Channel Diagnosis" on the bus controller.

Channel Diagnosis can also be individually enabled or disabled for each separate module. This is done using menu
option "IOM Channel Diagnosis" in the configuration menu of the respective module.

On Channel Diagnosis for the module enabled
Off Channel Diagnosis for the module disabled

7.2 Alarm table

The following tables contain information about bytes 7 and 8 (error type) of the diagnostic information. For more
information, see "Structure of the diagnostics system" on page 27.

7.2.1 General alarms

The alarms of the "ChannelErrorType-1" include general error messages.
Alarm/

Error number
Error message Alarm description

0x0000 Reserved Unknown error
0x0001 Short circuit Short circuit
0x0002 Undervoltage Undervoltage
0x0003 Overvoltage Overvoltage
0x0004 Overload Overloading
0x0005 Overtemperature Overtemperature
0x0006 Line break Open circuit
0x0007 Upper limit value exceeded Upper limit value overshot
0x0008 Lower limit value exceeded Lower limit value undershot
0x0009 Error Error
0x000A Simulation active Simulation active

0x000B - 0x000E Reserved Unknown error
0x000F Default for "Parameter missing"1) The channel requires an additional parameter. No or too few parameters writ-

ten
0x0010 Default for "Parameterization fault"1) Parameter error. Incorrect or too many parameters written
0x0011 Default for "Power supply fault"1) Power supply fault
0x0012 Default for "Fuse blown/open"1) Fuse defective
0x0013 Default for "Communication fault"1) Communication fault. Incorrect sequence or sequence number
0x0014 Default for "Ground fault"1) Ground fault
0x0015 Default for "Reference point lost"1) Reference point lost
0x0016 Default for "Process event lost / Sampling error"1) Process event lost / Sampling error
0x0017 Default for "Threshold warning"1) Threshold warning
0x0018 1)Default for "Output disabled" Output disabled
0x0019 Default for "FunctionalSafety event"1) Functional safety event
0x001A Default for "External fault"1) External fault

0x001B - 0x001E Manufacturer-specific Manufacturer-specific
0x001F Default for "Temporary fault" Temporary fault

1) For older devices "Manufacturer-specific"
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7.2.2 Safety-related alarms

The alarms of "ChannelErrorType-2" comprise alarms that are triggered in connection with safety functions.
Alarm/

Error number
Error message Alarm description

0x0020 - 0x003F Reserved for common profiles Reserved
0x0040 Functional safety 0 Safety target addresses do not match
0x0041 Functional safety 1 Safety target address invalid
0x0042 Functional safety 2 Safety source address invalid or does not match
0x0043 Functional safety 3 Safety watchdog time is set to 0 ms
0x0044 Functional safety 4 Parameter "F_SIL" exceeds SIL of the device application
0x0045 Functional safety 5 Parameter "F_CRC_Length" does not match the generated value
0x0046 Functional safety 6 Version of the F-Parameter invalid
0x0047 Functional safety 7 Data in received FParameter block is inconsistent (CRC1 error)
0x0048 Functional safety 8 Device-specific or undefined diagnostic information, see data sheet
0x0049 Functional safety 9 Store iParameter: Watchdog time exceeded
0x004A Functional safety 10 Restore iParameter: Watchdog time exceeded
0x004B Functional safety 11 Inconsistent iParameters (iParCRC error)
0x004C Functional safety 12 F_Block_ID not supported
0x004D Functional safety 13 Transfer error: Inconsistent data (CRC2 error)
0x004E Functional safety 14 Transfer error: Timeout
0x004F Functional safety 15 Acknowledge needed to enable the channel(s)

0x0050 - 0x005F Functional safety 16 to functional safety 31 Reserved
0x0060 - 0x00FF Reserved for common profiles Reserved

7.2.3 Manufacturer-defined alarms

The manufacturer-defined alarms of "ChannelErrorType-3" can be divided into 3 groups:

• Bus controller alarms
• I/O module alarms
• Channel Diagnosis alarms

The alarms and alarm texts listed in the following tables are defined in the GSDML file. Each GDSML file also
contains a complete list of the errors for each X2X module.
These are the alarm texts that will be displayed in the PROFINET master environment.

Bus controller alarms

A bus controller alarm is triggered if the bus controller detects an internal error. These alarms have nothing to
do with the current I/O module configuration; instead, there are problems with the IP address, the firmware or
resources are insufficient, for example.

Alarm/
Error number

Alarm text
"PN_BC_STATUS"1)

Error message Alarm description

0x200 xx_FLASH_FAILED Flash resource error A general flash resource error has occurred.
0x201 xx_INVAL_BC_CFG_DATA Faulty BC configuration data Faulty bus controller configuration data exists.

If faulty I/O module configuration data is de-
tected, a warning alarm is issued (PN_BC_S-
TATUS_IOM_BASED).

0x202 xx_IOM_NUM_EXCEEDED Maximum number of modules exceeded The number of permissible I/O modules has been
exceeded for the current X2X configuration.

0x203 xx_IORT_DAT_EXCEEDED I/O sync data length exceeded The maximum I/O sync data length has been ex-
ceeded for the current X2X configuration.

0x204 xx_NO_IP_ADDRESS Invalid IP address This alarm can only be triggered if DHCP mode is
enabled and an error occurs when assigning the IP
address.

0x205 xx_DUPLICATE_IP_ADD IP address exists multiple time The bus controller has detected several identical IP
addresses on the network.

0x206 xx_OUT_OF_RESOURCES Hardware resource problem The bus controller has insufficient resources to car-
ry out its expected operations (hardware, RAM,
etc.).

0x207 xx_INVALID_FIRMWARE Invalid firmware The bus controller detected faulty firmware during
booting or a firmware download.

0x208 xx_FATAL_ERROR General error Unspecified fatal error

1) xx in the alarms indicates "PN_BC_STATUS", e.g. xx_FLASH_FAILED → PN_BC_STATUS_FLASH_FAILED
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I/O module alarms

The bus controller constantly monitors the configured I/O modules during the startup phase as well as in state
"Operational". If a module is removed during runtime, for example, the bus controller reports this to the master
immediately by triggering the appropriate alarm. The bus controller responds to missing or incorrect modules, for
example, but it will also issue an appropriate alarm when it evaluates faulty configuration data or incorrect module
states.

Alarm/
Error number

Alarm text
"PN_IOM_STATUS"1)

Error message Alarm description

0x300 xx_MISSING Missing I/O module Missing I/O module detected during the boot
phase. This alarm is interpreted as a warning only,
not as an error.

0x301 xx_MISMATCH Incorrect I/O module An incorrect I/O module (module different than the
one configured) was detected in the boot phase.

0x302 xx_UNSUPPORTED Unsupported I/O module Unsupported I/O module detected during the boot
phase.

0x303 xx_FAILED Faulty I/O module Faulty or missing I/O module detected during oper-
ation.

0x304 xx_INVALID_CFG_DATA Faulty I/O module configuration The configuration data for an existing configured
module is faulty.

0x305 xx_REGACC_ERROR Register access not possible Obsolete firmware is being used.

1) xx on the alarms indicates "PN_IOM_STATUS", e.g. xx_MISSING → PN_IOM_STATUS_MISSING

Channel Diagnosis alarms

The status registers of the I/O modules are evaluated during Channel Diagnosis. In the event of Channel Diagnosis
errors, the bus controller sends an alarm and makes an entry in the diagnostics buffer. This entry contains the
error and slot number.
The diagnostics are acyclically queried by the PROFINET master. For possible causes and error corrections, see
the data sheet of the respective I/O module.

Information:
This function is available starting with bus controller firmware version 1.6. A firmware update can be
requested from International Support.
Alarm/

Error number
Alarm texts
"PN_IOM_CHANNEL_STATUS"1)

Error message Alarm description2)

0x0400 xx_UNDERFLOW Underflow Underflow
0x0401 xx_OVERFLOW Overflow Overflow
0x0402 xx_CONVERSIONERROR Conversion error Converter error
0x0403 xx_SUMERROR Sum error Composite error
0x0404 xx_SENSORERROR Sensor error Sensor error
0x0405 xx_VOLTAGEERROR Voltage error Voltage error
0x0406 xx_CURRENTERROR Current error Current error
0x0407 xx_STALLERROR Stall error Stall error
0x0408 xx_PHASESHIFTCURRENTERROR Phase shift current error Phase shift current error
0x0409 xx_PHASESHIFTVOLTAGEERROR Phase shift voltage error Phase shift voltage error
0x040A xx_CHECKSUMERROR Checksum error Checksum error
0x040B xx_ENCODERSUPPLYVOLTAGEER-

ROR
Encoder supply voltage error Encoder supply voltage error

0x040C xx_SINCOSERROR Sin/Cos error Sine/Cosine error
0x040D xx_POSITIONERROR Position error Position error
0x040E xx_COMMUNICATIONERROR Communication error Communication error
0x040F xx_COLLISIONDETECTION Collision detection Collision detection
0x0410 xx_PWMERROR PWM error PWM error
0x0411 xx_STARTBITERROR StartBit error StartBit error
0x0412 xx_STOPBITERROR StopBit error StopBit error
0x0413 xx_PARITYERROR Parity error Parity error
0x0414 xx_RXOVERRUN RX overrun RX overrun
0x0415 xx_IOLINK_PARASERVERLOCKED IO-Link parameter server locked IO-Link parameter server locked
0x0416 xx_IOLINK_PARASERVEREMPTY IO-Link parameter server empty IO-Link parameter server empty
0x0417 xx_IOLINK_NEWSERIALNO IO-Link new serial number detected IO-Link new serial number detected
0x0418 xx_IOLINK_INVALIDDATA IO-Link invalid data from parameter server IO-Link invalid data from parameter server
0x0419 xx_IOLINK_INVALIDID IO-Link invalid device or vendor ID IO-Link invalid device or vendor ID
0x041A xx_IOLINK_INVALIDSERIALNO IO-Link invalid serial number IO-Link invalid serial number
0x041B xx_IOLINK_TIMESTAMPERROR IO-Link timestamp error IO-Link timestamp error
0x041C xx_IOLINK_PARASERVERERROR IO-Link general parameter server error IO-Link general parameter server error
0x041D xx_CANWARNING CAN warning CAN warning
0x041E xx_CANPASSIVE CAN passive CAN passive
0x041F xx_CANBUSOFF CAN bus offset CAN bus offset

1) xx on the alarms indicates "PN_IOM_CHANNEL_STATUS", e.g. xx_UNDERFLOW → PN_IOM_CHANNEL_STATUS_UNDERFLOW
2) For more detailed information, see the documentation of the respective I/O module
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7.2.4 Network-related alarms

The alarms of "ChannelErrorType-4" include general network error messages.
Alarm/

Error number
Meaning Alarm description

0x8000 Data transmission impossible Data transmission impossible
0x8001 Remote mismatch Remote mismatch
0x8002 Media redundancy mismatch Media redundancy mismatch
0x8003 Sync. mismatch Sync. mismatch
0x8004 IsochronousMode mismatch IsochronousMode mismatch
0x8005 Multicast CR mismatch Multicast CR mismatch
0x8006 Reserved Reserved
0x8007 Fiber optic mismatch Fiber optic mismatch
0x8008 Network component function mismatch Network component function mismatch
0x8009 Time mismatch Time master does not exist or problem with accuracy occurred
0x800A Dynamic frame packing function mismatch Dynamic frame packing function mismatch
0x800B Media redundancy with planned duplication mismatch Media redundancy with planned duplication mismatch
0x800C Reserved Reserved
0x800D Multiple interface mismatch Information about multiple interface problems

0x800E - 0xFFFF Reserved Unknown error
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8 Acyclic communication

Values that are not available as cyclic data points on the PROFINET bus can be queried using the acyclic read
and write functions.

• When using bus controller X20BC00E3 in combination with PROFINET controller X20IF10E1-1, the acyclic
communication function blocks of Automation Studio library "AsNxPnM" can be used.

• When using bus controller X20BC00E3 with a Siemens PROFINET controller, acyclic communication func-
tion blocks RDREC/SFB52 and WRREC/SFB53 of the Siemens STEP 7 and TIA portals can be used.

This makes it possible configure I/O modules at a later point and to query things such as status values that are
not automatically transferred. The record read and write mechanisms can be used to read and write I/O module
registers. This is always a synchronous process (i.e. each read or write action only provides a result once the bus
controller has internally completed the asynchronous read or write action for the respective register). This ensures
that multiple acyclic processes cannot influence one another, and that the registers are accessed serially instead.
Only the index addresses 0x7000, 0x7001 and 0x7002 from the vendor-specific pool are used for the read and
write processes. Little-endian format is used for all record read and write procedures!

Information:
This function is available beginning with firmware Version 1.6. A firmware update can be requested
from International Support.

8.1 I/O module register functions

A register read access always requires 2 actions:

1) The desired register address must be defined with a "Record write".
2) The value of the previously defined I/O module register can now be read out with a "Record read".

8.1.1 Reading I/O module register

Writing I/O module register address
Index 0x7000
Data length 2 byte output = 2 byte register address
Return value OK (see spec: IEC 61158-6)

Error class Error number

11 Access 1 "write length error"

Master Slave

Writing register address

Response with error code

Structure of the register address: Slot, subslot, index 0x7000
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Reading I/O module register value
Index 0x7001
Return value 4 byte register value, INT32 (little-endian)

Error class Error number
10 Application 9 "Feature not supported"
10 Application 2 "Module failed"
11 Access 2 "Invalid slot/subslot"
12 Resource 2 "Resource busy"
12 Resource 3 "Resource unavailable"

Master Slave

Read request

Data

Structure of the read query: Slot, subslot, index 0x7001

8.1.2 Writing I/O module register

Index 0x7002
Data length 6 byte output = 2 byte register address + 4 byte data
Return value OK (see spec: IEC 61158-6)

Error class Error number
10 = Application 9 = "Feature not supported"
11 = Access 1 = "write length error"
11 = Access 2 = "Invalid slot/subslot"
12 = Resource 2 = "Resource busy"
12 = Resource 3 = "Resource unavailable"

Master Slave

Register address + data

Response with error code

Structure of the register address: Slot, subslot, index 0x7002

8.2 Slot assignments

X20BC00E3
Slot 0 is always the PROFINET bus controller. Slot 1 is the supply module on the X20BC00E3. (X20PS9400 or
X20PS9402). The slots are then assigned to the X2X modules in order.
Subslot 1 should be used for reading and writing acyclic data.
X67BCE321.L12
The X67BCE321.L12 module uses 2 slots. Slot 0 is the bus controller and slot 1 is the I/O module integrated in the
bus controller. The following modules begin from slot number 2.
Subslot 1 should be used for reading and writing acyclic data.
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9 Integrated website

The integrated website gives the user an overview of the bus controller's network parameters, the configured I/
O modules and the switch configuration. The starting page includes information regarding specific bus controller
settings such as IP address, hostname and the PROFINET device name. In addition, the website provides infor-
mation about the current firmware version. Information concerning module diagnostics is incorporated into a tree
structure. Expanding and collapsing the individual module nodes provides an overview of the configured I/O mod-
ules. In addition, various package counters are read from the integrated switch. This makes diagnosing errors on
the network quick and easy.
Network parameters concerning the bus controller itself can be read, but they cannot be modified. The bus con-
troller's IP configuration is handled during booting or by the PROFINET master when a connection is established.
Each page of the website contains help information that describes the functions and parameters displayed on that
page. The link to this information can be found in the upper right corner of the page in the form of a question mark.
A connection to the website is established by entering the current IP address or the unique hostname in a Web
browser. Some functions require authentication.
The hostname is composed of a predefined text and a unique MAC address. For example, if the bus controller has
the MAC address 00:60:65:11:22:33, this will result in the following hostname: br006065112233.
Default parameters available for the integrated website

IP address: 192.168.100.1
Username: admin
Password: B&R

Information:
Take note of the node number switch position.
Please note that authentication parameters are case-sensitive.
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9.1 Changing the device name

In order to change the device name, set the node number switch to 0xFF and restart the bus controller. By doing
so, the bus controller starts up with default parameters (see "Node number switches" on page 10).
● Subsequently, connect to the IP address 192.168.100.1 using an Internet browser. Enter in the desired name
for the Device name parameter under Network settings on the start page of the integrated website. Confirm this
by selecting the Set button.

● If the name has been saved to flash memory, then a message appears.

Information:
If you confirm this message by clicking OK, the current device name is shown again for the "Device
name" parameter. The name which has been newly set only becomes effective after restarting the bus
controller.
This function is available beginning with firmware Version 2.0.

Now the bus controller with the 0x00 node number switch position and the configured drive name can be restarted.
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9.2 Reset bus controller to its factory settings

It's possible to reset the bus controller to its factory settings using the integrated website.
To do this, click on the Advanced button on the left of the website. After doing this, a window appears which allows
the login data to be read or changed.

In addition, the button Restore PN Factory Defaults appears. This deletes the bus controller's flash memory and
restores it to its factory settings. It behaves in the same as the node number position 0xF0.
In principle, all node switch positions with which you can access the website are permitted.
You have to be logged into your account for all activities in the Advanced area. (See "Integrated website" on page
35.)

Information:
This function is available beginning with firmware Version 2.0.
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10 Firmware update

New functions and improved versions of the bus controller can be implemented by updating the firmware update.
Firmware files are provided by the B&R support team.
Firmware is updated via the website integrated in the bus controller itself.
It's also possible to perform module firmware updates of X2X modules that are connected to the bus controller.
The procedure for this is identical for the firmware update of the bus controller

Information:
This function is available beginning with firmware Version 2.0.

10.1 Firmware update via website

● To update the firmware, there must first be an active web connection to the bus controller using a web browser
(e.g. Firefox, Internet Explorer, Chrome, etc.). This connection can be established by entering the current IP ad-
dress of the bus controller in the web browser. If the bus controller is booted with its default parameters (see "Node
number switches" on page 10), then the default IP address is 192.168.100.1.
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● Once this connection to the bus controller has been established, the user can navigate to the Firmware download
menu option in the tree to the left. This option is located under the Advanced heading. Up on the right you can
find the Login button.

● After pressing the Login button, an input field appears where the user can enter the configured username and
password. The username admin and password B&R are set by default.
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● Click on Browse to select the desired firmware file. The firmware download is then started by clicking Start
Download. A pop-up window appears indicating the download progress. Once the firmware is finished download-
ing, the Restart bus controller button in the window is enabled and the bus controller can be restarted. New
firmware only becomes active after the bus controller is restarted.
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11 Commissioning with Step 7

Much of the following information can also be found in the "SIMATIC, Configure Hardware and Connection with
STEP 7" manual for the SIMATIC Step 7 software from Siemens. This can be downloaded free of charge in the
documentation area of the http://www.automation.siemens.com website.
All screenshots depicted here were generated using the Step 7 version indicated below. Nevertheless, B&R
PROFINET bus controllers can also be used with older software versions without any problems. While there may
be differences in how the user interface is arranged, the menu structure generally remains the same.
The bus controller X67BCE321.L12 was used for this example. The use of the X20 variant is identical. There
shouldn't be any difficulties integrating the bus controllers when using this document as a reference.

Software/Hardware used:
• B&R PROFINET bus controller
• GSDML file from the B&R website
• CPU315-2 PN / DP Siemens CPU as the PROFINET master
• SIMATIC Step 7 V5.5

11.1 Creating a new project

● The first thing to do after opening the SIMATIC development environment is to create a new project. This can
be done by selecting File → New. The project name must be entered in the selection dialog box. The project is
then created by clicking OK.

http://www.automation.siemens.com
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11.2 Inserting a SIMATIC 300 station

● The next thing to do is add a SIMATIC 300 station to the new project. This is done by right-clicking on the
project name, selecting →"Insert new object" and then choosing → "SIMATIC 300-Station". This specific station is
inserted since the PROFINET master being used (CPU 315-2PN/DP) is part of the SIMATIC 300 product family.

11.3 Open hardware configuration

● Double-clicking on Hardware in the SIMATIC 300 station opens the hardware configuration. A new window is
opened for this.
The hardware configuration serves as the basis for the entire PROFINET configuration. This is where the GSDML
files will be imported and the PROFINET master and slave configured as needed.
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11.4 Configuring the PROFINET master

● The PROFINET master is configured in the newly created hardware configuration. However, a RACK-300 com-
ponent must be inserted into the development environment.
Components from the Hardware Catalog are added to the current hardware configuration using drag-and-drop.

● This is where the CPU315-2PN/DP will be inserted.
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● When this CPU is added, the software asks the user if a new PROFINET network should be created. The network
is then added to the project by selecting New...
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11.5 Importing the GSDML file

● To configure the bus controller in the hardware configuration, its GSDML file must be imported into the SIMATIC
development environment. This is done using the Options → Install GSD file menu option.

● The path to the stored GSDML file is then specified in the dialog box, and the PROFINET device is imported
by selecting Install.
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11.6 Configuring the PROFINET bus controller

● Once the GSDML file has been imported, the bus controller is available in the updated Hardware Catalog. A
folder called "B&R PN Bus Controller" is created under the heading "PROFINET IO / Additional field devices → I/
O. The bus controller can then be added to the new PROFINET network with drag-and-drop.

Double-clicking on the bus controller opens its properties window where the device name and IP address can be
set. The PROFINET master can only establish a connection to the bus controller if the configured device name
matches the actual name of the bus controller. By default, bus controllers are delivered without an assigned device
name. They must first be preconfigured with the necessary name using the configuration tool integrated in Step 7
(see "Configuration using Step 7 configuration tool" on page 22). Another option is to assign the PROFINET device
name of the bus controller using the node number switches (see "Node number switches" on page 10).
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11.7 Modifying the default configuration

Information:
This section should only be applied when using the X67 bus controller.

When adding the bus controller, the module X67DM1321.L12IO (16 channel I/O) is also automatically added to
slot 1.

However, the default module must be deleted and replaced by another in order to use other functions from the
integrated I/O module.
Example
In order to use the counter function, the first module must be replaced by the module X67DM1321.L12_C1IO or
the module X67DM1321.L12_C2IO (for gate measurement).
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11.8 Add symbol names for created data points

Once the bus controller has been configured, all of the I/O modules in the project can be used in the project.
When an I/O module is dragged to the respective grid bellow the bus controller, the I/O data points needed for the
module are automatically created. A symbolic data point name is entered in the GSDML description file for each
of these data points. These symbolic names can later be imported to the Step7 master environment to provide
better orientation.
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All of the symbol names from the GDSML can be automatically added by clicking on Add to Symbols and applied
to the project by selecting OK or Apply.
Blank symbol table

Figure 2: Blank symbol table

Figure 3: Updated symbol table with data point names from the GSDML description file
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11.9 Configuration download

When adding the bus controller, the following I/O module is also automatically added to Slot 1:

• for X67BCE321.xxx: X67DM1321.L12 (Digital I/O module)
• for X20BC00E3: X20PS9400 (power supply)

Due to automatic insertion of the I/O modules on Slot 1, a valid configuration is already available that can be
downloaded at any time. Other modules can be added later by dragging and dropping. When a configuration is
loaded, the previous hardware configuration is automatically saved and compiled beforehand.
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12 TIA portal

Software and hardware used for this example:

• X20BC00E3 B&R PROFINET bus controller
• GSDML file from the B&R website
• CPU315-2 PN / DP Siemens CPU as the PROFINET master
• TIA portal version 13 (test version)

12.1 Creating a new project

● After opening the TIA Portal development environment, a new project must first be created. To do this, select
Create new project and specify the name and path of the new project. The new project is created with button
Create.

● After the project is created, the necessary devices can be added and configured.
The first step is to select Configure a device.
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● The CPU used is selected using Add new device and added to the configuration with button Add.



 TIA portal

PROFINET IO user's manual Bus controller 1.45 53

12.2 Adding PROFINET bus controllers

● To add a PROFINET bus controller, you must switch to the hardware view. To do this, select Device configuration
by double-clicking in column Project tree.

● The hardware structure can be checked or updated via tab Network view.

● In order to use the B&R bus controller, its description file must first be installed. The description file can be
downloaded from the B&R website and installed via Options → Install general station description file (GSD).

● The downloaded description file is selected in the dialog box and added to the project with button Install. This
adds the bus controller to the Hardware Catalog of the TIA Portal.
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● Now the installed B&R bus controller can be used in the project. This is done by selecting the bus controller in
the Hardware Catalog and pulling it into the project using drag-and-drop.

● The installed CPU and the bus controller are connected via PROFINET. For this purpose, the PROFINET interface
of the CPU is connected to the PROFINET interface of the bus controller via drag-and-drop.

● To establish communication between the PROFINET IO controller (master) and PROFINET IO device (slave),
the PROFINET device name stored on the bus controller must match the name configured in the TIA Portal.
The PROFINET device name of the bus controller can be set as follows:

• Using the node number switches. See "Node number switches" on page 10.
• Using an external tool. See " Changing PROFINET device names with Automation Studio" on page 20.
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To set the PROFINET IO device name in the TIA Portal, select the PROFINET bus controller (X20BC00E3) from
the drop-down list in the Device overview. By double-clicking on the image of the module, the setting options
become visible below. The desired PROFINET IO device name must be set here.
If "Generate PROFINET device name automatically" is active, the default name stored in the PROFINET IO device
is assigned automatically.
In addition, the IP address must be assigned. An IP address is assigned from the address range of the PROFINET
IO controller by default. This IP address corresponds to the management IP address of the CPU. For more infor-
mation, see "Establishing a connection to the hardware" on page 59.
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● In addition, further configurations can be carried out for the module.

● After modules are added, they can be easily configured by selecting them.
Example
The "End address" of a module is read out via Properties → General → I/O addresses in order to be able to link
it with a variable created in the application.
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12.3 Creating the application

● An application can be added via Project tree → Program blocks.

● If a new program is created via Add new block, first the name of the block as well as the programming language
are set and confirmed by clicking OK.
In this example it is SCL (Structured Text), although any programming language can be used.
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● The block is broken into two parts

• Variables can be created in the upper portion of the block.
• The application is programmed in the lower portion.

Example
A variable named "Test" and with data type "BYTE" should be created and assigned using the application of the
value 10.

● Now a tag can be created in the application so that the variable can be linked with an output via an address.
This is created with "%QB + address" or "%IB + address":
Example
The tag %QB256 is assigned to the "#Test" variables.
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12.4 Establishing a connection to the hardware

● To establish a connection from the TIA Portal to the CPU, the IP address and CPU subnet mask must be config-
ured in the TIA Portal. To do this, select the CPU in the Device view. Clicking on the Ethernet interfaces with the
mouse opens the corresponding window in menu "Properties". The IP address and subnet mask can be entered
here. The management IP address of the CPU corresponds to the PROFINET IO controller IP address.

● Now the project can be translated. For this, the "PLC_1[CPU 315-2 PN/DP" CPU is selected from the Project
tree view and the Compile button is selected in the toolbar.
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● After the project has been successfully translated, it can be loaded to the device. To do this, click on Download
to device in the toolbar.

● A dialog box opens in which the interface configuration can be set.
Click on Start search to search through the network for devices. If no devices are found, this indicates that the
IP address was set incorrectly in the CPU.
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● The devices found are listed under Compatible devices in target subnet after a successful search. After se-
lecting the CPU, the data can be loaded to the CPU by clicking on Load.

● Before loading, a notification window is opened that lists a preview of all loading cycles. This way you can check
if the correct data is being transferred. After clicking on Load, the data is transferred.

● The result of the loading cycle is listed and must be confirmed by selecting Finish.
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● The Go online button is selected to establish a connection to the CPU. The connection is established and the
slave is set to the run state if it is configured properly.
No change to the configuration and application can be carried out in the run state.

● The connection to the CPU can be disconnected by selecting Go offline.

● The application can be started and stopped by clicking on Start CPU and Stop CPU in the toolbar.
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